
  
 

Evaluation Kit Manual  

SDAH01 
Evaluation Kit for the HS3001 Humidity and Temperature Sensor 

  

R36UH0004EU0100   Rev.1.00 
Aug 27, 2021 

 Page 1 
© 2021 Renesas Electronics  

 
 

The SDAH01 Evaluation Kit is used to assess the 
HS3001 High-Performance Relative Humidity and 
Temperature Sensor. The hardware allows users to 
perform data logging experiments, and it can 
communicate through a standard USB interface with 
the user’s computer using the Demo Software. This 
software can be used to view measurements in real-
time, adjust the resolution of the sensor, configure 
measurement parameters, and download previously 
logged measurements.  

The evaluation board can be powered directly from 
the USB port of the user’s computer or from a 1632 
coin cell battery to enable fully autonomous 
(untethered) data logging.  

Board Contents 
■ SDAH01 evaluation board 
■ Three HS3001 sensor modules  
■ Sensor module extension cable 
■ USB cable 
  

Features 
■ Relative Humidity Sensor Module with HS3001 

sensor module:  
● RH accuracy: ±1.5%RH 
● Operating temperature: -40 to 105°C 

■ Demo Software: 
● Data plotter 
● Measurement resolution configuration 
● Data export 

■ Sensor module extension cable allows extending 
the HS3001 Sensor Module to different 
measurement areas 

 

Figure 1. SDAH01 Evaluation Kit 



SDAH01 Evaluation Kit Manual 

 

R36UH0004EU0100   Rev.1.00 
Aug 27, 2021 

 Page 2  

 

Contents 
1. Functional Description .................................................................................................................................. 3 

1.1 Setup and Configuration ........................................................................................................................ 3 
1.1.1. Computer Requirements ......................................................................................................... 3 
1.1.2. Software Installation and Setup .............................................................................................. 3 

1.2 Kit Hardware Connections ..................................................................................................................... 4 

2. Using the EVK ................................................................................................................................................ 5 
2.1 Measurement Settings ........................................................................................................................... 5 
2.2 Exporting Data ....................................................................................................................................... 6 
2.3 Data Logging Mode (Untethered) .......................................................................................................... 6 
2.4 Data Logging Settings ........................................................................................................................... 7 
2.5 Using the Plotter .................................................................................................................................... 7 
2.6 Valid Settings Ranges ........................................................................................................................... 7 

3. Ordering Information ..................................................................................................................................... 7 

4. Revision History ............................................................................................................................................ 7 

 

Figures 
Figure 1. SDAH01 Evaluation Kit ............................................................................................................................. 1 
Figure 2. Initial Display after Installation of the Demo Software ............................................................................... 3 
Figure 3. Evaluation Kit Connections ....................................................................................................................... 4 
Figure 4. Start Measurements .................................................................................................................................. 4 
Figure 5. Measurement Settings .............................................................................................................................. 5 
Figure 6. Set Resolution ........................................................................................................................................... 5 
Figure 7. Battery Installation ..................................................................................................................................... 6 
Figure 8. Download Data to Demo Software ............................................................................................................ 6 
 



SDAH01 Evaluation Kit Manual 

 

R36UH0004EU0100   Rev.1.00 
Aug 27, 2021 

 Page 3  

 

1. Functional Description 

1.1 Setup and Configuration 

1.1.1. Computer Requirements 
A Windows®-based computer is required for interfacing with the kit and configuring the device. The user must 
have administrative rights on the computer to install the Renesas Demo Software for the kit.  

The computer must meet the following minimum systems requirements: 
■ CPU – Intel or compatible 
■ RAM – 512MB 
■ Operating system – Windows® XP / Vista / 7 / 8 / 10  
■ Ports – One available USB port 

1.1.2. Software Installation and Setup 
Complete the following procedure to install the Demo Software: 

1. Plug in the USB flash drive to start the setup.  
2. If the setup process does not start automatically, double-click on the Setup.exe file. 
 

 
Figure 2. Initial Display after Installation of the Demo Software 
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1.2 Kit Hardware Connections 
Complete the following procedure to set up the kit as shown in Figure 3: 

1. Install the software from the USB flash drive or download from renesas.com as described in Software 
Installation and Setup. 

2. Connect one of the HS3001 sensor modules facing up, with or without the extension cable attached, into the 
sensor module connector 1 . 

3. Connect the USB port 2  of the board to the user’s computer using the supplied USB cable, and ensure that 
the power switch 3  on the board is in the USB position. The “USB” LED 4  will light. 

4. Run the Demo Software package from the Start menu, and click on the “Measure” button 5 . The 
“Measuring” indicator 6  will blink whenever data is being captured. 

Figure 3. Evaluation Kit Connections 
 

 

 

 

 

Figure 4. Start Measurements 
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2. Using the EVK 

2.1 Measurement Settings 
To change the interval and number of measurements to be made, select Measurement Settings from the Tools 
menu, enter the desired values, and then click OK, as shown in Figure 5. For the range of valid settings for these 
two entry fields, see Valid Settings Ranges. 
 

 

 

Figure 5. Measurement Settings  
 

To change the measurement resolution, select Set Resolution from the Tools menu, select the desired 
resolution, and then click OK, as shown in Figure 6. The resolution setting is stored on the sensor, and it will be 
the default value applied when measurements are started. Measurement settings can be changed only when no 
measurements are being taken. 
 

 
Figure 6. Set Resolution 
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2.2 Exporting Data 
The data displayed in the plotter area can be exported in two different formats. 
■ To export the measured data points in a Microsoft Excel® compatible comma-separated text file, select Save 

Data from the File menu. Create a filename for the data, and select the location where the file will be saved. 
■ To export the plots themselves as a picture file, right-click on the plot area and select Save Image As. Create 

a file name, select the location, and select the file type for the image.  

2.3 Data Logging Mode (Untethered) 
Disconnect the kit from the computer. Ensure that a battery is inserted in the battery holder on the back of the 
board with the positive battery terminal facing away from the board, as shown in Figure 7. 
 

 

Figure 7. Battery Installation  
 

Complete the following to operate the kit in the data logging mode (see Figure 2). 

1. To set the board to the data logging mode, put the power switch 3  in the “Batt” position. 
2. To start data logging, hold the “Start/Stop Logging” button 7  for 3 seconds. The “Measuring” indicator 6  

will light for 2 seconds and then start blinking on every logged measurement. This can be disabled to extend 
the battery life by toggling the “L2 Enable” switch 8 . 

3. To stop data logging, press the “Start/Stop Logging” button. The “Measuring” indicator blinks 3 times to 
indicate the end of data logging. 

4. To download the logged data to the Demo Software, connect the USB port 2  to the computer using the 
supplied USB cable, and ensure that the power switch 3  on the board is in the USB position. The “USB” 
LED 4  will light. 

5. In the software, select Data Logging from the Tools menu and click on the Download Data button 10  as 
shown in Figure 8. The maximum number of measurements that can be stored on the board is 2000.  

 

 
Figure 8. Download Data to Demo Software 
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2.4 Data Logging Settings 
To change the data logging measurement interval, select Data Logging from the Tools menu, and then click on 
Change Interval. Enter the desired measurement interval, and click OK. 

The data logging resolution can be selected in the same method as described in Valid Settings Ranges. Data 
logging settings can only be changed when no measurements are being taken.  

2.5 Using the Plotter 
The plotter 9  displays the measured relative humidity and temperature data simultaneously versus time (see 
Figure 3).  
■ Hold the left-mouse button, and drag it around an area to zoom onto that area.  
■ Hold the middle mouse or scroll button, and drag to pan across the plot area.  
■ To undo a zoom or pan operation, right click on the plot area, and select Un-Zoom (Un-Pan).  
■ The plot area can always be reset to the default view by right clicking on the plot area and selecting Undo All 

Zoom/Pan.  
■ To display the measurement points on the plotted curves, right click on the plot area and select Show Data 

Points. While moving the application window, measurements points will not be plotted. 

2.6 Valid Settings Ranges 
Measurement settings can be selected within the following ranges:  
■ Measurement interval: 0.5 to 3600 s 
■ Number of measurements: 1 to unlimited 
■ Data logging interval: 1 to 250 s 
■ Measurement resolution: 8, 10, 12, 14 bits 
 

3. Ordering Information 
 

Part Number Description 

SDAH01 SDAH01 Evaluation Kit, including SDAH01 evaluation board, HS3001 sensor modules, sensor 
module extension cable, USB key with Demo Software, USB cable 

 

 

4. Revision History 
 

Revision Date Description 

1.00 Aug 27, 2021 Initial release.  

 

 



Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
www.renesas.com

Contact Information
For further information on a product, technology, the most 
up-to-date version of a document, or your nearest sales 
office, please visit www.renesas.com/contact-us/. 

Trademarks
Renesas and the Renesas logo are trademarks of Renesas 
Electronics Corporation. All trademarks and registered 
trademarks are the property  of their respective owners.

IMPORTANT NOTICE AND DISCLAIMER

RENESAS ELECTRONICS CORPORATION AND ITS SUBSIDIARIES (“RENESAS”) PROVIDES TECHNICAL 
SPECIFICATIONS AND RELIABILITY DATA (INCLUDING DATASHEETS), DESIGN RESOURCES (INCLUDING 
REFERENCE DESIGNS), APPLICATION OR OTHER DESIGN ADVICE, WEB TOOLS, SAFETY INFORMATION, AND 
OTHER RESOURCES “AS IS” AND WITH ALL FAULTS, AND DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED, 
INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE, OR NON-INFRINGEMENT OF THIRD-PARTY INTELLECTUAL PROPERTY RIGHTS.

These resources are intended for developers who are designing with Renesas products. You are solely responsible for (1) 
selecting the appropriate products for your application, (2) designing, validating, and testing your application, and (3) 
ensuring your application meets applicable standards, and any other safety, security, or other requirements. These 
resources are subject to change without notice. Renesas grants you permission to use these resources only to develop an 
application that uses Renesas products. Other reproduction or use of these resources is strictly prohibited. No license is 
granted to any other Renesas intellectual property or to any third-party intellectual property. Renesas disclaims 
responsibility for, and you will fully indemnify Renesas and its representatives against, any claims, damages, costs, losses, 
or liabilities arising from your use of these resources. Renesas' products are provided only subject to Renesas' Terms and 
Conditions of Sale or other applicable terms agreed to in writing. No use of any Renesas resources expands or otherwise 
alters any applicable warranties or warranty disclaimers for these products.

(Disclaimer Rev.1.01)

© 2025 Renesas Electronics Corporation. All rights reserved.

https://www.renesas.com/contact-us
https://www.renesas.com

	1. Functional Description
	1.1 Setup and Configuration
	1.2 Kit Hardware Connections

	2. Using the EVK
	2.1 Measurement Settings
	2.2 Exporting Data
	2.3 Data Logging Mode (Untethered)
	2.4 Data Logging Settings
	2.5 Using the Plotter
	2.6 Valid Settings Ranges

	3. Ordering Information
	4. Revision History

